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New to MediaAgent? A handy Quick Start guide will help you in-
stall the software and begin monitoring your Eventide recorders right
away.

Familiar with MediaAgent but need some direction? Try the list of
Frequently Asked Questions to find some answers.
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1 Overview

About Eventide MediaAgent

Eventide MediaAgentTM allows you to monitor audio data from Eventide commu-
nications logging recorders such as the Atlas Series recorders or DIR911t instant
recall recorder. Locate records by time and channel (or groups of channels). Once
found, you’ll be able to listen to and export their audio.

Quick Start

Install MediaAgent

By default, the MediaAgent installation program places the executable in a loca-
tion accessible to all users on your system. It is recommended that you accept
the default installation location. It can be installed over previous installations of
MediaAgent .

If this is an upgrade installation, all previous configuration files will be automati-
cally upgraded the first time MediaAgent is run.

Connect to your Eventide Recorder

When starting MediaAgent for the first time, you are prompted to add a source
(see figure 1). A ’source’ is an Eventide Atlas Series recorder, or a DIR911t
instant recall recorder. Select Yes, and proceed to add one or more Eventide Atlas
Series recorders (by supplying the recorder IP address or host name). For more
about configuring sources, see the Options Reference section.

Filter and Play Records

After connecting to a source, close the Options window. The fastest way to lo-
cate records is to choose a channel with activity on the ’Instant Recall’ tab, which
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Figure 1: Adding a Source

should now be displayed before you. Set the time frame suitably (a few hours in
the past) and records will be retrieved and displayed for you.

Once records are displayed, press the Play button located in the transport at the
bottom of the screen (see figure 3). The first record in the list will begin playing. To
play a different record, double-click it (or highlight it and press Enter). Information
about the currently playing record will be displayed above the playback controls
at the bottom of the screen. You can also adjust volume and playback speed, or
change playback position (scrub) within the call using the playback controls. For
more, see the Playback Reference section.

Learn More

Once you have retrieved records, a number of options are available. In addition to
listening to the audio, you can export the audio data to disk; see Exporting Audio.
Numerous other monitoring tools are available within MediaAgent, including live
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Figure 2: The Instant Recall Tab

Figure 3: The Playback Controls

channel monitoring (see Channels), alarm monitoring (see Recorders), and instant
recall (see Instant Recall).

Troubleshooting

Several common problems are covered in the Frequently Asked Questions sec-
tion of this manual. Check it to see if the issue is already known, or if there is a
workaround available. Also consult any release notes for your version of MediaA-
gent .

It is Eventide’s policy to work directly with dealers, not end users. Dealers must
report issues to Eventide with the following information in order to process the
service/support request:
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1. Serial numbers of any recorders in use (whether Atlas, DIR911t)

2. Software versions for both the recorders(s) and MediaAgent

3. Severity of the issue, including a detailed description of the issue

4. Contact information (phone and email) for dealer and on-site technician

To contact Eventide Customer Service for support, call 201-641-1200 option 6 then
option 2 (Communications/Loggers division), or email support@eventide.com.
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2 Workflow

Overview

MediaAgent is primarily an instant recall client with a set of additional monitoring
tools. This section outlines some of the more common workflows which MediaA-
gent supports. It covers the most common options and features available. For more
detailed explanations, see the Reference section.

Typical Workflows

MediaAgent is geared toward users who need to quickly locate the most recent
data on their Eventide recorders. As calls appear on the recorder, MediaAgent will
display the new call data in real time. See the Finding and Organizing Records
section below for more information.

Once records are displayed, they can be examined, updated and listened to. See the
Examining and Playing Records section below for more information.

MediaAgent can also monitor different aspects of your Eventide recorders, includ-
ing live audio feeds and system alerts and status. See the Monitoring Recorders
section below for more information.

Finding and Organizing Records

The typical workflow for finding data involves the following steps.

1. Filters Create filters that encompass one or more channels on your Eventide
recorders.

2. Setup tabs Create a new tab for each filter.

3. Time ranges Set your time range on each tab.

9
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Creating Filters

Filters are used in Instant Recall to limit the live record view. A filter is a single
channel name, or a Channel Group. Use the Filters Options to define which filters
are visible in an Instant Recall tab.

Figure 4: Creating Filters

To add a channel name filter, select one or more channels from the Channels list
and click the associated arrow button. To add a Channel Group filter, select one or
more groups from the Groups list and click the associated arrow button.

For more information see the Filters reference section.
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Setting up Tabs

The most efficient organization for monitoring a recorder with Instant Recall is to
create one tab per filter. See the reference section for more information.

Introducing Instant Recall

Figure 5: The Instant Recall Tab

The Instant Recall tab provides a configurable window into the activity on one or
more channels. To open a new Instant Recall tab, select File →New Tab → Instant
Recall from the application menu, or press the corresponding Ctrl+R hotkey.

The Instant Recall tab’s main controls are positioned along the top of the screen.
Select from drop-down list of channel filters to narrow the instant recall window.
All activity falling within the displayed time period will appear, sorted by start
time. To adjust the time period, enter a new value for hours and minutes and the
Instant Recall tab will automatically refresh the data displayed. To play audio for
any of the records listed, simply highlight it and press Enter.

For more information about audio playback, see the Playback Reference section.
For further details on configuring Instant Recall, see the Instant Recall Options
section.
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Examining and Playing Records

The typical workflow for examining and playing records involves the following
steps.

1. Find Records in Instant Recall Tabs Locate new records

2. Playback Audio Select individual records for playback.

3. Update Records If necessary, records can be updated.

Finding and Organizing Records

Follow the steps outlined in the Finding and Organizing Records section for details
on locating new records on your Eventide recorder.

Playing Audio

To begin playing audio for a record, simply press the “Play” button in the playback
area at the bottom of the screen. The first record in the list will begin playing
(or, if you have a different record selected, the selected record will begin playing
instead). Alternatively, select a record and press Enter to begin playback. Use
the Spacebar hotkey to begin or pause playback. The Spacebar hotkey also has
the special property of being able to pause playback at any time, from any area of
MediaAgent. If audio is playing, and you need to stop it, simply press the spacebar
once.

Playback of an individual record can also be started by double-clicking it. Or,
right-click the desired record to present an option to “Start Playback”. Select this
to begin audio playback on the selected record. Again, audio can be stopped again
by tapping the spacebar or by pressing the “Pause” button in the playback area at
the bottom of the screen.

MediaAgent can only play audio from a single record at a time. Once the record
has played through to the end, audio playback will stop.

12



Examining and Playing Records Eventide MediaAgent

Updating Records

Once records have been located, there are a number of ways to examine their prop-
erties. Records can be sorted in any direction using any available column. Ex-
amine detailed properties for any record by right-clicking a record and selecting
“Properties”. Figure 6 shows the “Properties” dialog for a record. This includes
information such as the Notes and Audit History of the record.

Figure 6: Properties Dialog

Any Notes modified in this dialog are saved back to the recorder it originated on.
Similarly, changing the “Protected” status of a record updates the record’s status
on the source recorder.

13
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Exporting Audio

MediaAgent can export audio from your Eventide recorders in the format in which
it was recorded.

Once records are visible in an Instant Recall tab, invoke the export dialog by right-
clicking the desired record and choosing “Export selected” from the menu which
appears. A dialog appears allowing you to select a filename for the exported audio.
Choose a filename and select “OK” for the audio to be exported.

Monitoring Recorders

MediaAgent enables you to monitor the live audio feeds from your Eventide recorders.
In addition, there are tools to monitor recorder health and status, as well as channel
activity.

Introducing Channels

The Channels tab provides a real-time overview of the physical recording channels
on a source. To open a new Channels tab, select File → New Tab → Channels
from the application menu, or press the corresponding Ctrl+L hotkey.

The Channels tab displays all physical channels in a list below each source. Each
channel is displayed with the current channel name, the channel number and the
current channel status. To enable live monitoring of the audio currently playing on
the channel, toggle the “Live Monitor” icon for the desired channel. To enable or
disable recording on a channel, toggle the “Record Enabled” checkbox. The audio
for more than one channel at a time can be monitored. Adjust the overall volume
level with the volume slider at the bottom of the screen.

Introducing Recorders

The Recorders tab provides information about recorder drive status and alarms.
To open a new Recorders tab, select File → New Tab → Recorders from the
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Figure 7: The Channels Tab

application menu, or press the corresponding Ctrl+E hotkey.

Select a source from the list of connected sources. The “Drive Status” table lists all
configured drives and their current status. This includes network drives and local
DVD-RAM archiving drives.

The “Alarms” table lists all active alarms that may be present on the selected
source. To acknowledge an alarm, select it from the list and press the “Acknowl-
edge” button. Consult with your network administrator to fully resolve any recorder
configuration issues that you have acknowledged.
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Figure 8: The Recorders Tab
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3 Reference

Overview

This section builds on the previous Workflow section and provides details about
each window, option, tab and menu in MediaAgent. For general MediaAgent us-
age, review the Workflow section. For detailed information on specific options or
controls, consult this reference.

Main Window

Figure 9: MediaAgent Main Window

The MediaAgent main window is your primary workspace. The main window uses
a tabbed approach to organize information. Tabs are located across the top of the
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window. Clicking a tab will cause it to become active. The default main window
contains an Instant Recall tab. See the Tabs section for details on each type of tab.

Tabs

Channels

Figure 10: Elements of the Channels Tab

The Channels tab provides live status information for all physical channels on your
Eventide communications logging recorder. Each connected source appears in the
channels list. Expanding the tree of information will reveal all channels on the
source. To sort the list of channels, click on the “Channel Name” or “Channel
Number” header; a small arrow will indicate the sort direction. To reverse the sort,
click the header section again.

18
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The current, live audio on each channel can be monitored by clicking on the “Live
Monitor” icon next to the desired channel. Multiple channels can be monitored at
the same time. Adjust the overall volume with the volume control at the bottom of
the screen.

In addition, the recording state of the channel can be changed. Click the “Record
Enabled” checkbox to enable and disable active recording on a channel. If des-
elected, any audio currently being recorded will stop until the “Record Enabled”
checkbox is enabled again.

The status of each channel is displayed in the “Channel Status” column. A colored
square indicates the current status. The colors correspond to the following states:

Green - The channel is enabled, but is not recordering any audio.

Red - The channel is enables and is also recording audio.

Yellow - The channel is disabled.

Grey - The channel is disabled by the system, or not recognized. Consult your
system administrator for details.

Instant Recall

The Instant Recall tab provides a live picture of the activity on a channel. By
default, Instant Recall will contain filters for each channel name on a connected
source. (To create customized filters, see the Filters section.) The records displayed
in the record view will correspond to the selected filter, and will also correspond to
the specified time range. To adjust the time range, enter a new value for “Hours”
and “Minutes”; Instant Recall will automatically refresh the record view for you.
To change the channel which is displayed, select a new channel name from the
channel drop-down list; records will be automatically refreshed. To manually re-
fresh the record view, select Tools → Refresh from the application menu, or press
the correspond F5 hotkey.

The Record View The record view presents data in a table. Sort the information in
any way by clicking on the appropriate column header. A small arrow will indicate
the sort direction. To reverse the sort, click the column header again. Columns
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Figure 11: Elements of the Instant Recall Tab

can also be reorganized in any way. Click and drag any column header and drop
it into a new position. The type and number of columns can also be customized.
Right-click any column and a menu of available column names will appear. To add
a column, select it from this menu. To remove a column, deselect it. To reset the
columns to their user-defined default value, select the “Reset to Default” option
(for more on this, see the Default Columns section).

To play audio in Instant Recall, double-click the desired record. Or, highlight the
record and press the Enter key. Audio playback will begin. Instant Recall only
supports sequential record playback. See the Playback section for details.

Recorders

The Recorders tab displays live drive and alarm information for your connected
sources. Select a source in the sources list to display its status information. The
drives reflect the current number and status of drives on the selected source. As
drives are added or removed from the recorder (for example, a network archive),
the drive status list will automatically update itself. The alarms list will display the
current active alarms on the source. As new alarms occur, the list will automati-
cally update. To acknowledge an alarm, highlight it and press the “Acknowledge”
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Figure 12: Elements of the Recorders Tab

button. Also consult with your system administrator about any active alarms.

Playback

MediaAgent supports a single playback mode, single record playback. Audio can
be streamed from an Eventide recorder only. Audio volume and playback speed
can both be adjusted, and seeking to random playback positions (“scrubbing”) is
supported.

Playback Controls

Playback is controlled via the playback control area at the bottom of the screen.
All playback controls have corresponding hotkeys associated with them to make
audio playback more efficient.
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Figure 13: Elements of the Playback Control Area

Scrubbing Changing the playback position is known as scrubbing. You can scrub
during playback at any time. To quickly move to a different audio position within
a record, click and drag the scrub slider control at the bottom of the screen. While
scrubbing, keep an eye on the new position using the playback time indicator.

Variable Speed Adjust variable speed playback using the playback controls at the
bottom of the screen (audio playback speed cannot be adjusted for “live” audio
streams, for example when monitoring channel audio in the Channels tab). To
increase the speed of playback, adjust the “SPEED” slider. The relative pitch of
the audio playback will not be affected, only the rate at which it is played. This is
convenient to quickly review audio, or to slow things down to discern difficult-to-
understand sections.

Options

This section explains all options available in the Options window of MediaAgent.
To change or view an option, click on the option name in the list along the left side
of the Options window.

Sources

Maintain all MediaAgent sources here. To add a new connection to an Even-
tide communications logging recorder or to an Eventide DIR911t instant recall
recorder, click the “Add” button. In the dialog that appears, enter the necessary
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Figure 14: The Options Window

information (including user name and password) and press the “OK” button. Me-
diaAgent keeps a running list of all the sources that have ever been added. To
completely remove a source from the list, select it and click the “Remove” button.
When adding a source, you can optionally instruct MediaAgent to remember your
password. If you enable this option, MediaAgent will be able to log in to the source
immediately, without prompting you for a password, the next time it starts.

All connected sources will be reconnected when restarting MediaAgent.

MediaAgent can connect or disconnect from any of the listed sources, as necessary,
from the Sources Options page. To reconnect to a source, select it and click the
“Connect” button. To disconnect, use the “Disconnect” button. It is often more
convenient to temporarily disconnect from a source, and reconnect to it later on,
without having to go through the processing of adding it from scratch each time.
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General

Modify general application settings here.

Minimize to system tray To prevent MediaAgent from shutting down when clos-
ing the main window, turn this option on. Instead of exiting the application, it will
be minimized to the system tray of the task bar. MediaAgent can be easily restored
by double clicking the system tray icon or by right-clicking the system tray icon
and choosing ”Restore MediaAgent”.

Play first track on double-click restore from system tray Enable this option to
have the first track in the active Instant Recall window begin playing if you double-
click to restore MediaAgent from the system tray.

Alarm Notification Enable this option to be notified of active alarms on any of
your connected sources.

Elevate Configuration Press this button to copy your current MediaAgent config-
uration to the machine defaults. You must be a system administrator to perform
this function.

Channel Groups

A “Channel Group” is a collection of one or more channel names. MediaAgent
utilizes Channel Groups in the Instant Recall tab.

In the Instant Recall tab, Channel Groups can be selected as the active filter. This
allows Instant Recall to monitor more than one channel at a time.

To create a new Channel Group click the “Add Group” button. You will be prompted
for the group name. After the group is created it is initially empty; add channels
to it by first selecting one or more channels from the list on the left. Then press
the arrow button to add the selected channels to the group. Add channels from a
different source by selecting one from the drop-down list above the channel list.

Edit an existing Channel Group by selecting it from the “Groups” list. Remove
individual channels from a group by first selecting them, and then clicking the “Re-
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move Channel” button. Remove an entire group by clicking the “Remove Group”
button.

Filters

Filters are used in Instant Recall to limit the live record view. A filter is a single
channel name, or a Channel Group. Use the Filters Options to define which filters
are visible in an Instant Recall tab.

To add a channel name filter, select one or more channels from the Channels list
and click the associated arrow button. To add a Channel Group filter, select one or
more groups from the Groups list and click the associated arrow button.

The order in which the filters appear in the Instant Recall tab can also be adjusted
here. To change the order of filters, select one or more filters from the Visible list
and then click the up or down arrow to change the relative order.

To prevent a filter from showing up in Instant Recall, select it from the Visible list
and click the “Remove Filter” button.

Instant Recall

Configure Instant Recall options here. Since Instant Recall is intended to monitor
recent channel activity, there is a maximum record limit to each Instant Recall
tab. Set the maximum record limit here. It is recommended that you leave this
setting at the default, or lower, value. Increasing the limit may have performance
implications.

In addition, each Instant Recall tab contains a default time window, within which
records are displayed. Change the default value for new Instant Recall tabs by
adjusting the “Hours” and “Minutes” values.
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Playback

Adjust global playback behavior here. Certain analog capture boards are occa-
sionally prone to small continuity jitters while recording audio. To suppress warn-
ings about these audio anomalies, ensure that “Ignore Audio Discontinuities” is
checked. Uncheck this option to see all audio continuity warnings while playing
audio.

Adjust the audio “Skip Interval” here as well, which specifies the number of sec-
onds to be skipped forward or backward when using this scrubbing technique.

Default Columns

Specify the default columns to be displayed when opening a new tab which con-
tains a record view. From the available column list on the left, select a column
to add and click the right arrow button. To remove a column, select one from the
list on the right and press the left arrow button. The order in which the default
columns are displayed can also be altered; select a column from the list on the
right and adjust its position by clicking the up/down arrow buttons. s

Change Password

For those sources that support it, your current password can be changed. Select
the source from the list and enter your “New password” in the entry box. Repeat
the password and press the “Apply” button. Your password will be changed on the
source recorder and will need to be used on subsequent logins.

Menus

File

New Tab Opens a new tab in the active top-level window. Choose a tab type from
the submenu which appears.
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Close Tab Closes the active tab on the active top-level window. You cannot close
the last tab.

Exit Exits MediaAgent.

Playback

Toggle Playback Starts or stops audio playback.

Play Selected Starts audio playback on the selected record. If there is no selection,
the first record in the list will begin playing. If the active tab does not contain a list
of records, this option is not available.

Next Record Skips to the next record as listed in the record view.

Previous Record Skips to the previous record as listed in the record view, or skips
to the beginning of the current record, depending on the playback position. If
the playback position is near the beginning of the audio, MediaAgent skips to the
previous record. If the playback position is somewhere in the middle of the audio,
skips to the beginning of the currently playing record.

Skip Forward Scrubs forward by a user-defined number of seconds, by default 10.
Scrubbing remains within the bounds of the currently playing record.

Skip Back Scrubs backward by a user-defined number of seconds, by default 10.
Scrubbing remains within the bounds of the currently playing record.

Loop Playback Loops audio playback between user-defined start and end looping
points.

Tools

Refresh Refreshes the list of records in the active tab. If the active tab does not
contain a list of records, this option is not available.
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Options... Opens the MediaAgent Options dialog, where various application set-
tings can be adjusted.

Help

Contents... Invokes the MediaAgent help.

Quick Start... Invokes the MediaAgent Quick Start help.

Frequently Asked Questions... Invokes the MediaAgent Frequently Asked Ques-
tions help.

What’s This Activates “What’s This?” mode. Once activated, click on a MediaA-
gent control for more specific, context-sensitive help information.

About Displays the MediaAgent version and copyright information.
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4 Frequently Asked Questions

Overview

Answers to some of the most common questions about MediaAgent are found be-
low.

Questions and Answers

How can I work with records in Microsoft Excel?

Information can be moved from an Instant Recall tab to Microsoft Excel using
copy-and-paste. In the Instant Recall tab, first select a record. Then press the
Ctrl+C hotkey to copy the record information to the clipboard. Switch to Excel
and paste the information into a spreadsheet.

Why can’t I use Instant Recall over a larger time range?

Your user account may be limited by your system administrator to a specified time
window. So check with your system administrator. Otherwise, to research older
records on your Eventide recorder, use the separate MediaWorks client application.

I’ve created a Channel Group for Instant Recall, but cannot see it in the In-
stant Recall tab! What gives?

After creating a Channel Group, make sure it the group is also part of the Visible
Filters. In the Options window, select “Filters” from the list on the left. You will
see your newly created Channel Group in the “Group” list. Select it and press the
right-arrow button to add it to the “Visible” list. This Channel Group will now be
available to all your Instant Recall tabs.

Certain channel names from my logger are not appearing in MediaAgent.
Why is this happening?

If channel name information was recently altered on your Eventide recorder, it
may be necessary to restart MediaAgent and reconnect to the recorder before those

29



Eventide MediaAgent 4 Frequently Asked Questions

channel names are available in MediaAgent.

I’ve found a problem with MediaAgent, what do I do?

Troubleshooting

Several common problems are covered in the Frequently Asked Questions sec-
tion of this manual. Check it to see if the issue is already known, or if there is a
workaround available. Also consult any release notes for your version of MediaA-
gent .

It is Eventide’s policy to work directly with dealers, not end users. Dealers must
report issues to Eventide with the following information in order to process the
service/support request:

1. Serial numbers of any recorders in use (whether Atlas, DIR911t)

2. Software versions for both the recorders(s) and MediaAgent

3. Severity of the issue, including a detailed description of the issue

4. Contact information (phone and email) for dealer and on-site technician

To contact Eventide Customer Service for support, call 201-641-1200 option 6 then
option 2 (Communications/Loggers division), or email support@eventide.com.
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